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Tips
Supertree
How Do I Make Tree Displays More Readable?

Problem:  You have used numbers to specify outcomes for your spread-
sheet.  For instance, the value for Decision might be 1 for Build, 2 for
Joint Venture, 3 for Do Not Build.  Now you have evaluated the tree
and realize that when you have Supertree draw the tree, it is pretty
hard to explain what the branches labeled 1, 2, and 3 mean.

Solution:  Go to Input or Change Node Data and change the outcomes
from cryptic numbers to the actual words.  When you draw the tree,
Supertree will note that things have changed, but give you the opportu-
nity to retain the old values— respond Yes.  Warning:  If you save the
Supertree file in this form, you will not be able to use it to evaluate the
tree again unless you restore the original form of the outcomes.

Another solution: Paste the drawing into a program like PowerPoint
and double-click on the image to turn it into an editable object.  Edit
entries to replace cryptic indices with explanatory text.

How Do I Plot the Results From Different Trees on the Same Graph?

Problem:  You have several decision trees in different files and you
want to plot the cumulative (or histogram) probability distributions on
the same graph.  Or you wish to plot results obtained from the same
tree with the nodes in different orders.

Solution:  Use the Store Distribution option from the File menu to
store the information for each distribution and the Recall Distribution
option to reload the information and perform the plots.  If the first node
is a decision node and you want to store the distribution for each
alternative, specify the node at which to obtain the information as the
second node in the tree, and then you will be able to specify the branch
of the first node for which you want to store information.

How Often do I Make a “Downstream” Decision?

Problem:  Your decision tree has a decision (“Build a factory?”) followed
by several uncertainties (“How do cost, price, and volume turn out over
the next three years?”) followed by a “downstream” decision (“Expand
the factory?”) followed by some other uncertainties.  Under what
circumstances do you choose to expand the factory?
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Solution:  Display the tree up to and including the second decision
node; the display will show the “policy”— the decisions you make in
each situation.  Suppose there are too many branches to make much
sense out of this display.  Create a cell in the spreadsheet with a
formula like =IF(Decision_2=1,1,0) and have this be one of the result
measures returned to Supertree.  (You can return several result
measures by listing them, separated by semicolons— see p. 6-17.)  Roll
back the tree, making decisions on the primary value measure, but
displaying the result from the cell defined above; the result will be the
probability that you choose the branch of Decision_2 labeled 1.

What if my big tree exceeds Excel’s limits?

Problem:  Supertree writes one line per endpoint in supermacro.txt
(sometimes more if there are lots of nodes and the node names are
long), so supermacro.txt can be many lines long.  However, Excel 95
has a maximum of about 16,000 lines in a spreadsheet and Excel 97 a
maximum of about 64,000 lines. Suppose you exceed this limit.

Solution: You could eliminate a variable and make the tree smaller,
but there is a solution that enables you to have the full tree (assuming
you have time for the evaluation). Assume that node 99 is the last
decision/chance node in the tree and that it has three branches that
lead to node 100, the Excel endpoint.  Create a new endpoint, 101, that
is identical to 100, and have one of the branches of 99 lead to 101.
Supertree now thinks that 99 is asymmetric (not all successor nodes
are identical), so it goes through the branches of 99 one at a time.
The result:  three calls to the Excel spreadsheet, each with 1/3 the
number of evaluations, resulting in 1/3 the number of lines in
supermacro.txt per call.

Is there a simple way to enter a new order of nodes?

Problem: For a complicated tree, you have entered the nodes in
Supertree in the order that makes evaluation most efficient.  How-
ever, for the analysis, you need the nodes in a different order. It is a
bore to retype the list of nodes each time into the New Order of Nodes
box, and there is the possibility of an error in retyping. You use the
clipboard to copy and paste the graphics to PowerPoint, so you cannot
just store the new order of nodes on the clipboard.

Tips
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Solution: Open up Notepad (or some other application with text capa-
bilities) and type the order of nodes that you want there.   Then, after
you have pasted the graphic, switch to Notepad, copy the nodes, switch
to Supertree, paste into the New Order of Nodes box.  You can even
leave the list highlighted in Notepad so that all you have to do is press
Ctrl-C to copy the list.

What if I need to stop an Excel run during an evaluation?

Problem: You select Evaluate Tree and Supertree puts out a call to
Excel. You realize that there is an error in your information and you
want to halt the Excel run before it is complete.

Solution: Use Control + Break to halt the run. A Macro Error dialog box
will appear that gives you the following choices: Halt, Step, Continue,
Goto. If you choose Halt, the evaluation will terminate.

How can I make my Sensitivity Displays More User Friendly?

Problem: In Sensitivity, you may want to multiply some quantity (say,
Volume) by .90 and 1.15 for a sensitivity.  It is usually easier to explain
tornadoes by percent changes than by introducing the idea of a multi-
plier.

Solution: Use the Value variation and enter 90% and 115% for the low
and high values of the multiplier.  Excel will interpret these numbers
as .90 and 1.15, and Sensitivity will display 90% and 115% at the ends
of the tornado bar. The same type of entry can be used for node values
in Supertree.

How Do I Make Sensitivity Displays Even More Readable?

Problem:  You have used index numbers to specify outcomes for your
spreadsheet.  For instance, the value for Price Modifier might be 1 for
Low, 2 for Base, 3 for High— the spreadsheet figures out what to do
when it gets a value of 1, 2, or 3.  Now you have evaluated the sensitiv-
ity and realize that when you have Sensitivity display the tornado, it is
pretty hard to explain what the variations labeled 1, 2, and 3 mean.
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Solution:  Paste the drawing into a program like PowerPoint and
double-click on the image to turn it into an editable object.  Edit the
values shown at the ends of the bars, replacing the cryptic indices
with explanatory text.

How Do I Make Sure Sensitivity is Running the Right Alternative?

Problem:  You have a decision variable in your spreadsheet; if the cell
named decision contains the value 1, the spreadsheet evaluates the
Aggressive alternative, and for 2 it evaluates the Status Quo alterna-
tive.  How do I make sure that the sensitivity runs for the Aggressive
alternative.

Solution:  The simplest solution is to make sure you saved the
spreadsheet with the value 1 in the cell named decision.  More fool-
proof, however, is to include a variable in the sensitivity named
decision, with a base value of 1 and low and high values of 1.  This will
make sure the correct decision is evaluated and, because there is no
variation, the variable will be shown at the bottom of the “tornado” plot
and can be eliminated from the plot.

The following sections list a series of practices that have proved
valuable in performing decision analyses.  It is assumed that Excel is
the modeling language, but most of the practices can be implemented
in Lotus 1-2-3 or Quattro Pro spreadsheet construction.

Parameterize, Parameterize, Parameterize!

When building a spreadsheet, parameterize your input data as much
as possible.  For instance, place the initial period’s sales volume in a
single cell and a growth rate in another cell.  The numbers that
appear in the row for sales volume are developed by using an equation
involving the initial volume and the growth rate (see below) rather
than by directly entering a number into each cell.  The parametric
approach to spreadsheet construction is crucial when performing
sensitivity analysis and other forms of “what if” analysis.

Tips
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Keep All Input Together, Use Range Names, and Separate Calcula-
tions from Input

Completely separate calculations from input.  Experienced modelers
know the pain (and occasional panic) of trying to find out why things
are going wrong when input data is scattered through the spreadsheet.
Besides, keeping input together is a good way to document the analy-
sis.

Use range names for the cells containing input data.  Calculations
using these range names are much easier to understand and debug
than formulas that use cell addresses like B245.  In addition,
Supertree and Sensitivity can refer to these cells unambiguously—
neither Supertree or Sensitivity will know if you add a row and cell
B245 becomes cell B246, but the range name will still refer to the
correct cell.

Uncertainty is central to the application of Sensitivity and Supertree.
It is good practice to document uncertainty ranges in the spreadsheet.
One form is a table like the following:

The cells in the Value in Use column contain the data that is used in
the calculations.  The cells in the Name column contain the range
names for the cells in the Value in Use column.  The Low, Base, and
High columns contain the uncertainty range on the variables.

One advantage of keeping input data in this form is that it can be
imported into Sensitivity by the Import Variable Data command (see
Page 3-14).

A B C D E F G
1 Description Value in Use Name Low Base High Units
2
3 Price in 2000 $3.50 price_00 $2.50 $3.50 $3.75 $/unit
4 Price Growth Rate .02 price_gr .01 .02 .025 fraction/yr
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A B C D E F G H I
1 Description Value in Use Name Index Index

Name
Low Base High Units

2
3 Price in 2000 $3.50 price_00 2 price_00_i $2.50 $3.50 $3.75 $/unit
4 Price Growth Rate .02 price_gr 2 price_gr_i .01 .02 .025 fraction/yr

The calculations section would contain a line for Price as below:

The calculation is done by a formula like  =price_00*(1+price_gr)^(C10-
$C$10) entered into C12 and copied across.

Use Indices

Frequently modelers create an index that moves the data from the
Low, Base and High columns into the Value in Use column depending
on the value given to the index.  For instance, in the table below, the
formula in B3 might be =INDEX(F3:H3,D3).  More sophisticated forms of
indexing can use words instead of numbers— for instance, if the entry
in D3 were “Base,” the formula
=INDEX(F3:H3,MATCH(D3,{“low”,”base”,”high”},0)) in B3 would return
the base value.

Supertree and Sensitivity can write directly into either the Value in
Use cells or into the Index cells.

Parameterize the Alternatives

Input is more complicated when decisions are involved.  Create a cell
and associate an index with each alternative in the decision.  Input
can be entered as below, with different input lines for each alternative;
in the calculation, price growth rate might be entered in calculations
as CHOOSE (decision,price_gr_1,price_gr_2).

A B C D E F G H I
1 Decision 1 decision 1=Aggressive, 2=Status Quo
2
3 Description Value in Use Name Index Index Name Low Base High Units
4
5 Price in 2000 $3.50 price_00 2 price_00_i $2.50 $3.50 $3.75 $/unit
6 Price Growth Rate,1 .025 price_gr_1 2 price_gr_2_i .02 .025 .035 fraction/yr
7 Price Growth Rate,2 .02 price_gr_2 2 price_gr_2_i .01 .02 .025 fraction/yr

A B C D E F G
10 Year 2000 2001 2002 2003 2004
11
12 Price $3.50 $3.57 $3.64 $3.71 $3.79
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The preceding form is very convenient for Sensitivity where each
variable can be varied. However, it is less convenient for Supertree,
because separate nodes would be needed for price_gr_1 and
price_gr_2.

A second common choice is to use a more elaborate form of indexing,
as in the example below.

The entries in F6:H6 are formulas referring to data in cells K6:P6
shown below.  For instance, the formula in F6 could be
=INDEX(K6:P6,1+3*(decision-1)).

This form is convenient for both Supertree and Sensitivity because
only one variable name is used to describe price growth rate.

J K L M N O P
1
2
3
4 Alternative 1 Alternative 2
5 Low Base High Low Base High
6 .02 .025 .035 .01 .02 .025

A B C D E F G H I
1 Decision 1 decision 1=Aggressive, 2=Status Quo
2
3 Description Value in Use Name Index Index Name Low Base High Units
4
5 Price in 2000 $3.50 price_00 2 price_00_i $2.50 $3.50 $3.75 $/unit
6 Price Growth Rate .025 price_gr 2 price_gr_i .02 .025 .035 fraction/yr
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Troubleshooting
Sensitivity or Supertree Problems

Run the problem (or a simpler version) in Manual rather than Auto-
matic mode.  Stop the macro in the middle of the run (Control-Escape,
Control-Break, Control-C, or Command-.), and see what is happening.
Check the column you designated to hold the answers to see if the
answers are reasonable.  After the macro is run, open SUPERANS.txt
(Windows) or SUPERANS (Macintosh) from Excel, Lotus 1-2-3, or
Quattro Pro and see what values are in it.  Complete the evaluation
and see if nonzero answers have been picked up.

Supertree Problems

• Use Show Tree Structure or Show Schematic Tree in
the Structure menu to check for any error messages
below the node listing.

• Use Display Tree in the Analyze menu to examine the
first few nodes in the tree; maybe you can spot the
problem there.

• Use Trace Value in Tree in the Analyze menu to find
nonzero values, and then problem solve from there.

• Do List Distribution Values, Plot Distribution in the
Analyze menu, or Store Distribution in the File menu
give answers that are wrong or give too few points?

For big trees, Supertree collapses the distribution to an
approximately equivalent smaller distribution when it
reaches a certain size, so there may be fewer points.
Further, in collapsing the distribution, Supertree
creates some values in the list that are not actual
endpoint calculations.  To adjust the number at which
this reduction occurs, use Set Options in the File
menu.
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• Is Excel, Lotus 1-2-3, or Quattro Pro not called during
automatic evaluation? (Windows only). Click the Options
button while in the Enter or Change Model option (Sensitiv-
ity) or the Input or Change Node Data option (Supertree).
Make sure that Sensitivity or Supertree has the correct
location of the file that runs the spreadsheet program:

EXCEL.EXE for Excel
123W.EXE for Lotus 1-2-3
QPW.EXE for Quattro Pro.

• If Supertree (or, more rarely, Sensitivity) gives WS FULL
(workspace full) error messages, it means that there is
insufficient memory allocated to Supertree.  Use the APL,
Execute APL Expression option in the File menu, and enter
&WA; the answer given is the workspace available in bytes
and should be over 1 megabyte.

If you need to allocate more memory, follow these steps:

Windows

1. Quit the application.

2. Open the application Notepad from the Accessories
folder.

3. Open the file \super95\sup95.ini (\super95\sen95.ini
for Sensitivity) and edit the line with “Wssize” in it.  The
number after Wssize= is the amount of memory (in
Kilobytes) assigned to Supertree.  The amount usually
sufficient is 2500K for Supertree and 1024K for
Sensitivity.

4. Experiment with the correct settings.  Setting these
numbers too low leads to WS FULL errors.  Setting these
numbers too high leads to slower computer
performance.

Troubleshooting
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Macintosh

1. Quit the application.

2. Switch to the Finder.

3. Select Sensitivity or Supertree.

4. Choose Get Information from the File menu, and in-
crease the memory figure at the bottom of the informa-
tion screen.

• Does SUPERMACRO halt at one of the early cells (A2
through A6)?  This almost always means that one of the
range names (including the result name in the Sensitivity
model or Supertree endpoint) you have defined in Sensitiv-
ity or Supertree is not defined in the spreadsheet.  Check
spelling, particularly the possibility of confusing the letter
“l” with the number one or the letter “O” with zero.  Error
messages with the following forms will be seen:

IN EXCEL, “MACRO ERROR AT CELL: SUPERMAC.TXT!A2.”

IN LOTUS 1-2-3, “INVALID VALUE {LET}.”

IN QUATTRO PRO:

- “INVALID CELL OR BLOCK ADDRESS {LET}
[SUPERMAC.TXT]A:A2),” FOR AN INVALID VARIABLE NAME

(IN SENSITIVITY) OR NODE NAME (IN SUPERTREE).
- “NON-NUMERIC RESULTS WERE REPORTED FROM THE PROGRAM

RUN.  (THE FIRST DISALLOWED RESULT IS RESULT NUMBER 1:
[ ] RANGENAME,” FOR AN INVALID MODEL NAME (IN SENSITIVITY) OR

ENDPOINT (IN SUPERTREE).

If you are using a multisheet spreadsheet in Excel, make
sure that you save the spreadsheet with the sheet that has
the input calls as the active sheet.

Troubleshooting
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• If you are running an asymmetric tree (all successor
nodes are not identical) and Lotus 1-2-3 (version 4 or 5
only) crashes, check the file \windows\123R5.INI.  Find
the [DDE] section in the file and add the line
TermTimeout=0.

• Are you getting strange, wrong answers back?  Check for
the following problems:

– You might have defined ranges with names like CF93
for cash flow in 1993.  This sounds good, but Excel,
Lotus 1-2-3, and Quattro Pro interpret this as row 93
in column CF.  (In Excel, if you define a range name
CF93, Excel will change this to CF93_ and never tell
you!)  Avoid range names composed of letter-number
or letter-letter-number.

– Make sure the column(s) defined to store the results
is (are) empty.

– Does Sensitivity or Supertree say it found a
nonnumeric answer?  Sensitivity or Supertree reports
the first nonnumeric result sent to it.  A frequent
cause of nonnumeric answers is “division by zero” for
one of the cases.

– Did you name the endpoint with a range name c or r?
Excel will not allow c or r as a range name.  If you use
Formula Create Names, Excel will create names c_
and r_ and never tell you!  If you then use c or r as
endpoint value names, strange things happen.
SUPERMACRO would crash if c or r were used
anywhere other than in endpoint/model values.  In
endpoint/model values, Excel refuses to accept the
command but continues without notifying you.

Troubleshooting
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Troubleshooting
– Are the results being written to the wrong sheet and

writing over some code?  For Lotus 1-2-3 and Quattro Pro,
the first sheet (sheet A) is selected for the sheet to write
the answers to.  For Excel, the results are written to the
active sheet when the workbook is opened; this is the
same as the active sheet when the workbook was last
saved.

• Are you getting zeros when analyzing an evaluated sensi-
tivity or tree?  Here are some questions to ask:  (These
questions may also be useful when other puzzling answers
come back.)

– Did you evaluate?  If in manual mode, did you follow the
instructions for retrieving the answers after the Excel,
Lotus 1-2-3, or Quattro Pro run?

– Is the value to be returned actually the cell with the
answer in it?  Sometimes the wrong cell gets referenced,
and it is empty or zero.

– For Supertree only:  Is there a NO GO alternative with
value zero in the decision tree?  Sometimes the NO GO
alternative is the preferred alternative, so the value of
the decision tree is zero!

– Is the answer larger or smaller than one?  Sometimes
the values are like 0.02. Check Set Options in the File
menu (Macintosh only) to make sure that enough
decimals are shown (0.02 would show up as zero if the
field width was 8 0, which means 8 characters wide, 0
decimals).

A problem sometimes occurs when using GRMACROS.XLS to graph
Sensitivity results.  If you use double quotes in the variable description
(e.g., the “critical” variable), Excel doesn’t like it! Solution: Edit out the
double quotes before running GRMACROS.XLS.


